Overview
The Universal Transaction Gateway® (UTG®) encrypts and securely transmits transaction data from interfaced
merchant systems (POS, property management, eCommerce shopping cart, etc.) directly to Lighthouse Transaction
Manager (LTM) using Shift4’s proprietary Derived Unique Key Per Transaction with Moving Target Encryption
(DUKPT w/MTE). The UTG is a small application that is installed on the merchant’s computer network that
facilitates connectivity to Shift4’s data centers. It is proprietary Virtual Private Network (VPN) software that
protects the transport of sensitive financial data from interfaced systems to the LTM system. It performs assured
delivery, controls the most favorable route for transactions, and controls various smaller devices. You can also
control various devices connected to the workstation (POS terminal) to offer online debit transactions, check
verification, and electronic signature capture capabilities.

The UTG Installation and Configuration Guide
This version of the UTG Installation and Configuration Guide coincides with UTG release 3150 or greater and
provides the basic instructions for security, system preparation, installation and basic configuration of the UTG. For
details on external devices, see the Using External Devices document.

Authorization Flow with the UTG

The following example shows the credit card authorization flow with the UTG in place:

1.
2.
3.
4.
5.
6.
7.
8.

The point-of-sale (POS) or property management system (PMS) initiates a non-debit transaction with the UTG.
The authorization transaction is encrypted by the UTG using DUKPT w/ MTE.
The authorization transaction is sent using Shift4 secure payment network.
The authorization request is stored in the LTM database.
The transaction is sent to the bank card processor for authorization.
The authorization response is sent from the processor to LTM.
The authorization response is saved in the LTM database. The authorization response is encrypted by LTM
using DUKPT w/ MTE. The authorization response is sent to the UTG over Shift4 secure payment network.
The transaction response is sent back to the POS.
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Product Support
Shift4 has a world-class customer support team that is available to our customers 24/7/365 and is dedicated to
resolving every question.
Web: The website at https://www.shift4.com/support provides access to answers to general and technical
questions regarding the entire Shift4 product line.
Live Support: Information about troubleshooting techniques and handling special problems that may occur during
installation or configuration can be obtained by contacting the Shift4 Customer Support team at 888-276-2108.
Feedback: Your feedback regarding Shift4 products and documentation is welcome and encouraged and we
appreciate your comments. If you have any documentation comments or suggestions about this or any other
Shift4 product, please send them to us at techdocs@shift4.com.

Security and UTG
To ensure the UTG is installed, configured, and operating in a secure manner and environment that is compliant
with PCI DSS standards, you must read the following documents:
•
•
•

UTG PA-DSS Implementation Guide
UTG Installation and Configuration Guide
The latest version of the PCI DSS documentation at www.pcisecuritystandards.org

Warning! For security implementation and best practices, see the PA-DSS
Implementation Guide.

Use of a Payment Application Data Security Standard (PA-DSS) compliant application by itself does not
make an entity PCI DSS compliant, since that application must be implemented into a PCI DSS compliant
environment and according to the PA-DSS Implementation Guide provided by the payment application
vendor.
All applications that store, process, or transmit cardholder data are in scope for an entity’s PCI DSS
assessment, including applications that have been validated to PA-DSS. The PCI DSS assessment should
verify the PA-DSS validated payment application is properly configured and securely implemented per PCI
DSS requirements and the vendor’s PA-DSS implementation guide. If the payment application has
undergone any customization, a more in-depth review will be required during the PCI DSS assessment, as
the application may no longer be representative of the version that was validated to PA-DSS.
The PA-DSS requirements are derived from the PCI DSS Requirements and Security Assessment
Procedures. The PA-DSS details the requirements a payment application must meet in order to facilitate a
customer’s PCI DSS compliance. As security threats are constantly evolving, applications that are no
longer supported by the vendor (e.g., identified by the vendor as “end of life”) may not offer the same
level of security as supported versions.
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UTG Usage Configuration Examples
There are three common usage scenarios for UTG installations pictured below. The preferred method is to install
the UTG on every POS/PMS terminal. There are several reasons why this is the best scenario. First, with a UTG on
every terminal, the communication never has to leave the terminal before being encrypted. This is the ultimate
way to protect cardholder data. Second, with a UTG on every terminal, if one of the terminals goes down, the rest
of the system is not affected. Third, with a UTG on every terminal, the speed of the transaction may be enhanced
since communication between the terminal and the UTG does not have to occur over the network.

Important: It is important to have low latency between UTG and external
devices. Shift4 does not support UTG connecting to devices across a
WAN.

If you are using a Point-to-Point (P2PE) PIN pad, it can be connected directly to the server with the UTG, using an
Ethernet connection.
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High Availability Installation Considerations
Installing multiple UTGs provides a number of benefits including the following:
•
•
•

The ability to handle larger loads
High-availability
The ability to perform rolling maintenance

However, there are some factors to consider with multiple UTG installations:

If you are not using 4Go or UTG-controlled PIN Pads:
•

•

You can deploy as many UTG instances as you want behind the load balancer. Any UTG can handle the
requests as long as the correct data is being transferred, which would be a requirement for normal
processing as well. The Load Balancer will be responsible for ensuring that the origins and destinations are
kept in line with each other.
You can distribute the load with various solutions such as physical load balancers, software load
balancing, DNS, or whatever you are comfortable with. Shift4 does not advocate one method over the
other, so long as the factors listed here are kept in mind.

If you are using 4Go:
•
•
•

4Go must hit the same instance of UTG that the POS/PMS hits.
Your configuration must ensure that each instance of POS and 4Go is mapped to the same instance of
UTG. If they do not match, the UTG will not have the initial authorization request.
The recommended best practice is to install UTG on every terminal that uses 4Go. This is inherently a
load balanced solution, as every end-point has a UTG assigned to it.

If you are using UTG-controlled PIN Pads:
•
•

Each PIN Pad must be paired with a UTG. This is because the UTG broadcasts to the device and while one
UTG can service multiple devices, each device cannot be serviced by multiple UTGs.
The recommended best practice is to install a UTG on every terminal that uses a device. Again, this is
inherently a load balanced solution, as every end-point has a UTG assigned to it.
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If you are using EMV:
•

This will be under the same scope as using UTG-controlled PIN Pads.

Examples of High Availability Configurations
Warning! The configurations displayed in this section cannot be used with
UTG controlled devices. See the If you are using UTG-controlled PIN Pads
section above for more information.

Below are two examples of configuring your UTG installation for high availability.
1.
2.

The first example uses third-party load balancing software as part of the POS/PMS system.
In the second example, third-party load balancing hardware devices are used.

Both application delivery systems can use methods such as “round robin,” “least connections,” and “fastest
response” to maximize availability.

Load
Balancing
Software

Server
With UTG

Load
Balancing
Software

Load
Balancing
Software
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In this example a load balancer is used to distribute the load.

Load
Balancing
Hardware

Load
Balancing
Hardware
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Installing UTG
Shift4 provides an installer file containing the Universal Transaction Gateway (UTG) files required for installation.
Follow the steps in this chapter to install the UTG.

WARNING! Any prior versions of the UTG will be disabled once the current
version of the UTG is installed on your machine. However, the previous
settings of the UTG TuneUp will be retained.

Preparing for Installation
This section covers the infrastructure required to install and run the Shift4 UTG application and should be reviewed
carefully. Contact the Shift4 Installations team to schedule the installation at 888-276-2108. The installation may
be delayed if all items discussed in this section are not in place at the time of installation.

Note: Merchants, not Shift4, are responsible for magnetic card readers
(MSRs or wedges), servers, terminals, external devices (PIN pads), network
infrastructure, and the computer on which the UTG is installed.

System Specifications
To ensure a smooth installation process, the system should meet the following minimum requirements:
•
•
•
•
•
•
•
•

Processor equal to Intel Pentium 4.1, Intel Celeron, AMD Athlon, or newer
Minimum 800 MHz processor speed
Minimum 8 Gigabytes RAM
Minimum 4 CPU cores
Minimum 40 Gigabytes Hard Drive
Minimum 10/100 Megabit Network Interface Card
Shift4-supported Windows operating system with appropriate service packs and security updates (see the
bulleted list below for supported versions of Windows)
Static internal IP address per UTG

Higher volume merchants may require a more powerful system.
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Operating System Requirements
Verify that the PC chosen to run the UTG is using a supported Windows operating system with the appropriate
service packs and security updates installed. The supported Windows operating systems are listed below.

Important: When installing a UTG, if US English is not selected as the
language in Microsoft® Windows, the UTG may not function as designed.

Windows Requirements
The user account for the UTG must have full rights to the Shift4 UTG installation directory.
The UTG will be installed as a Service under the Local System account. If you are running UTG as a service, this
should be changed in Windows services to an account that is securely locked down.
To change from the Local System account to a more secure account, complete the following steps:
1.
2.
3.

From the Start menu, select Windows System > Control Panel > Administrative Tools > Services.
Double-click the Shift4 UTG2 service.
On the Log On tab, select This account and configure a different account with the full rights to the Shift4 UTG
installation directory.
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Windows Firewall
Shift4 conforms to the strictest security requirements. For security reasons, the UTG must be installed on a
machine behind a firewall. However, because a firewall restricts communication between your computer and the
Internet, it is necessary to adjust the settings for the UTG so it can communicate through the Windows firewall.
Listing the UTG as an exception will accomplish the task. If the UTG is not listed, you will need to add it to the
exception list.

Supported Windows Operating Systems

Note: UTG will work in a 64-bit or 32-bit environment. UTG can also
operate in a virtualized environment.

Important: Home versions of Microsoft operating systems are not
supported.

•
•
•
•
•
•

Microsoft® Windows 10
Microsoft® Windows 2019 Server
Microsoft® Windows 2016 Server
Microsoft® Windows 2012 Server
Microsoft® Windows 8
Microsoft® Windows 2008 Server

WARNING! Unless used with True P2PE™, installing the UTG on a nonsupported operating system is a violation of PCI DSS Requirement 6.2 and
may also render your systems more vulnerable to a security breach.

Tip: To stay fully compliant with security standards, as well as ensure
machine stability while running the UTG, make sure you keep the
machine up to date with the latest Windows updates.
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Interface Requirements
The UTG communicates with external devices (such as PIN pads and signature capture devices) in conjunction with
POS/PMS systems or other systems through various API connectivity methods. Before installation, verify that all
interfaces are listed as Shift4 certified on the Shift4 Partners web page https://www.shift4.com/our-softwarehardware-partners/. Not all interfaces are listed on the web page. If your interface is not listed, call Shift4. Verify
that all interface drivers are completely loaded and current.

Internet Connectivity Requirements
For security reasons, an internal static IP address is required on every machine with the UTG installed. In addition,
because of Card Association Security Requirements, the UTG must be installed on a machine that is protected
behind a firewall. It is the merchant’s responsibility to configure static IP addresses or networks.

Note: If you are in a DHCP environment, you can reserve an IP address to
make it appear static.

Connecting to Shift4’s data center requires outbound connections to TCP/IP ports 26880 and 26881. Configure the
firewall for a pool of established, resultant, server, or ephemeral traffic across these ports to successfully connect.
The exact name for the ephemeral type of resultant connection depends on the firewall’s naming conventions.
Specifically defined inbound connectivity policies are not required.

Warning! If you have multiple Internet connections, you need to have a
way to switch between connections. UTG does not automatically switch to
an alternate Internet connection.

Warning! When the term SSL is used throughout this document, it should be
interpreted as the newest version of TLS. In accordance with the PCI Data
Security Standard, all versions of SSL and TLSv1.0 are no longer considered
“strong encryption” and should never be used for non-console access to
card data environments through public networks or to transport card data
over public networks. Shift4 offers the option to use SSL and TLSv1.0 due to
system incompatibility issues with legacy PMS/POS systems, but it should
only be considered a temporary fix. If SSL or TLSv1.0 must be used, it should
only be used inside protected, non-public networks. For more information
see:
https://www.pcisecuritystandards.org/documents/Migrating_from_SSL_Earl
y_TLS_Information%20Supplement_v1.pdf
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CPU Utilization
If you experience high CPU utilization for a UTG, see the information below:
The UTG writes a large amount of log information for troubleshooting. It also securely wipes those files after
encrypting and compressing them. Those operations can consume a significant amount of CPU time. Below are
some ways to reduce the associated resource requirements:
1.

2.

3.

Set the “Bytes Each” parameter to a larger size. UTG default size is 20 MB. This means that as soon as the trace
file reaches that size, it will roll over and create a new file. When the number of trace files specified in the
“Max Files” setting in the UTG is reached, it will add the oldest file to a queue that is then encrypted,
compressed, and then securely wiped. The UTG then also starts a new file for the current trace. Increasing
that size may reduce your CPU utilization because it is more efficient to do this roll over less frequently, even
though the files are larger.
You may also want to consider excluding files with a .trc extension from your antivirus tool because antivirus
tools also consume CPU time monitoring those files as they are written, compressed, encrypted, and securely
wiped. Additionally, if the Antivirus has those files locked, the UTG may not be able to complete the process
described above.
If you are using Trend Micro, there are publically known issues with resource utilization. Excluding .trc files,
may mitigate some of those issues. Also, if you are running UTG on a VM and Trend Micro is monitoring the
VHD files for the VM, that can cause high CPU usage independent of UTG. There are several sites describing
related problems and solutions in more detail such as: https://success.trendmicro.com/solution/1059182.

Warning! Shift4 will not be responsible for any actions taken related to
antivirus tools and settings. The merchant is responsible for understanding
and applying any suggestions offered above.

Gathering Configuration Data
Refer to the Customer Configuration Report from Shift4 prior to proceeding with the installation. If you have not
received the report or do not have all the needed information, contact the Shift4 Installations team. Record or
have the following information available:
•
•

Serial number
Slot number

Note: The apiSerialNumber and apiPassword is needed if the interface isn’t
authenticating via Access Token(s).
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Running the Probe Utility to Test Your Internet Connection
Requirement: Ports 26880 and 26881 must be configured for outbound
traffic in your firewall before UTG installation. If the Shift4 Probe utility
runs successfully, the ports are configured properly.

The Shift4 Probe utility tests the system’s connection to Shift4. You must run the Shift4 Probe utility prior to
installing the UTG. To run the Shift4 Probe utility, complete the following steps:
1.

Go to https://myportal.shift4.com/downloads/s4probe.zip for the Shift4 Probe utility.
The file name and publisher should read s4probe.zip and www.shift4.com.
2. Click Open.
3. Double-click S4Probe.exe and click Run.
4. Click Next.
5. Verify that Connect to… via Internet using Normal Route is selected under Available Items. The Server, Port,
and Route Code fields will fill in automatically.
6. If connecting to the test server, change the server name to ns.shift4test.com.
7. Click Next.
8. Click Test. The test result should read SUCCESS. A Score other than 0 indicates a communication problem
between your system and Shift4. This may take some time.
9. Review the Results window.
The Results window will open and display the route scores. A max score is set up to determine the quickest
and most reliable routes to the Shift4 data centers. The optimal score is 0; a score other than 0 indicates a
communications problem on some level. The UTG will select routes with the best scores and use those routes
at random.
If you think there might be a Shift4 communication issue, call the Shift4 Support team at 888-276-2108.
10. Click Close to exit.
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Downloading the UTG
To download the UTG complete the following steps:
1.
2.
3.

Go to https://myportal.shift4.com/downloads/utg2setup.exe for the UTG setup file.
In the Downloads window, the name and location should read UTG2setup.exe and
https://myportal.shift4.com/downloads/utg2setup.exe. Click UTG2setup.exe and then click Run to continue.
On the next window, the file name and publisher should read Universal Transaction Gateway (UTG). Click Run.
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Installing the UTG
If you have any questions during the installation, contact the Shift4 Support team at 888-276-2108.
To install the UTG, complete the following steps:
1.

In the Universal Transaction Gateway Setup Installation Wizard window, click Next.

2.

In the Read the license agreement section, review the terms and conditions and click Next to indicate you
accept the license agreement.

© Shift4. All rights reserved.
External Use NDA

Version 5.8
Page 14 of 89

UTG Installation and Configuration Guide

3.

Under Choose folder, choose the folder in which you would like UTG2 to be installed, or click Next to install
the updated UTG files in the default Shift4 folder.

4.

In the Universal Transaction Gateway Setup screen, click Next.
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5.

In the Universal Transaction Gateway Setup screen, you have the option to select Run Universal Transaction
Gateway TuneUp now. If selected, UTG TuneUp will open when the installation is complete. Click Finish to
complete the installation process.

6.

In the Confirm screen, click Yes.

7.

Configure the UTG. See Configuring UTG in this document.
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Configuring UTG
The Universal Transaction Gateway TuneUp application is used to configure UTG settings, including interface and
external devices settings, communicating with the Shift4 data centers, and selecting advanced parameters. This
guide provides basic configuration for TCP/IP, HTTP, TCP/IP SSL, HTTP SSL, and UTG4Cloud interfaces. For other
interface types or if you have any questions on the configuration process, contact the Shift4 Support team at 888276-2108.

Requirement: If the UTG is running, you must shut it down before you can
configure the UTG TuneUp settings.

Configuring UTG TuneUp Settings Overview
To configure the Universal Transaction Gateway TuneUp complete the following steps:
1.

If the UTG is running, shut it down:
•
•

2.
3.
4.

To shut down UTG Standalone, select File > Exit and click Yes when prompted to confirm shut down.
If UTG Standalone is in use, it may be necessary to select Override before clicking Yes.
To shut down the UTG service, stop the Shift4 UTG (v2) service from the Windows Services menu.

From the Start menu, select Programs > Shift4 > Universal Transaction Gateway > UTG (v2) TuneUp.
In the UTG TuneUp window, configure the settings on each tab as required for your business processes.
To save your settings and changes in TuneUp, you must click Save on the Universal Transaction Gateway
TuneUp screen. Since clicking Save closes TuneUp, you may want to wait until you have made all of your
settings before you click Save. Click Save before closing the UTG TuneUp screen to save all your settings and
changes.
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Configuring Interfaces
The API Interfaces create connections from the UTG to the Interface Vendor system so that transactions can flow
back and forth.

Requirement: You must have all the required information, such as interface
connection, port address, device types and names, and other key
configuration requirements on hand before you proceed. To configure
Interfaces, the UTG Stand Alone must be shut down and the UTG TuneUp
must be running.

Adding a TCP/IP Interface
The TCP/IP interface uses TCP socket communication to connect to the UTG. It optionally provides encryption
through the use of a shared secret passphrase. To add a TCP/IP interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

Under Interface, click Add.
From the Add menu, select TCP/IP.
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2.

To configure the new interface, complete the following steps:
•
•
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Default is 17476 ($4444
for hex).
(Optional) In the Encryption Passphrase field, enter your passphrase. This encrypts traffic across the
network if the Interface Vendor system included similar encryption methodology.
(Optional) In the Verify Passphrase field, enter your passphrase.
(Optional) To enable Bank ID Number (BIN) management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the
BIN Management tool will automatically determine the card type and process the transaction as debit if
the amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit
or debit if the dollar amount is at or below that Floor Limit.

Note: When Swipe Ahead is used with BIN Management, the Floor Limit set
in UTG TuneUp is ignored and BIN Management automatically selects debit
if the card is debit capable. If the card is not debit capable, the UTG
prompts the cardholder.

o
3.
4.

The Bin Management Floor Limit specified is the lowest amount for which the Bin Management
function is enabled.

(Optional) To print a tip line on the receipt when an authorization is performed, select Print Blank Tip Line on
Authorizations.
(Optional) To print a tip line on the receipt when a sale is performed, select Print Blank Tip Line on Sales.

Note: If either Print Blank Tip Line on Authorizations or Print Blank Tip Line
on Sales is selected, the following should be noted:
•
•

5.

If the POS sends the tip amount, the tip line will not print on the
receipt.
If the user enters a tip amount on the PIN pad, the tip line will not
print on the receipt.

(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical Installation
Guide for more information.
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6.

Click OK.
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Adding an HTTP Interface
The HTTP interface, encrypted by the UTG, allows web applications to send traffic to Shift4 with much greater
security and reliability than using HTTPS posting directly over the Internet. To add an HTTP interface, complete the
following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

Under Interface, click Add.
From the Add menu, select HTTP.
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2.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. The default is the
standard HTTP protocol port of 16448 ($4040 hex).
(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the
BIN Management tool will automatically determine the card type and process the transaction as debit if
the amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit
or debit if the dollar amount is at or below that Floor Limit.

Note: When Swipe Ahead is used with BIN Management, the Floor Limit set
in UTG TuneUp is ignored and BIN Management automatically selects debit
if the card is debit capable. If the card is not debit capable, the UTG
prompts the cardholder.

o
3.
4.

The BIN Management Floor Limit specified is the lowest amount for which the Bin Management
function is enabled.

(Optional) To print a tip line on the receipt when an authorization is performed, select Print Blank Tip Line on
Authorizations.
(Optional) To print a tip line on the receipt when a sale is performed, select Print Blank Tip Line on Sales.

Note: If either Print Blank Tip Line on Authorizations or Print Blank Tip Line
on Sales is selected, the following should be noted:
•
•

5.

If the POS sends the tip amount, the tip line will not print on the
receipt.
If the user enters a tip amount on the PIN pad, the tip line will not
print on the receipt.

(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical Installation
Guide for more information.
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6.

Click OK.
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Adding a TCP/IP SSL Interface
The TCP/IP SSL API interface uses TCP socket communication to connect to the UTG. It provides an added layer of
security using SSL to secure the local network segment.
To add a TCP/IP SSL interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

2.

Under Interface, click Add.
From the Add menu, select TCP/IP SSL.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 21845 ($5555 hex) is
the default setting.
(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical
Installation Guide for more information.
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Warning! When the term SSL is used throughout this document, it should be
interpreted as the newest version of TLS. In accordance with the PCI Data
Security Standard, all versions of SSL and TLSv1.0 are no longer considered
“strong encryption” and should never be used for non-console access to
card data environments through public networks or to transport card data
over public networks. Shift4 offers the option to use SSL and TLSv1.0 due to
system incompatibility issues with legacy PMS/POS systems, but it should
only be considered a temporary fix. If SSL or TLSv1.0 must be used, it should
only be used inside protected, non-public networks. For more information,
see
https://www.pcisecuritystandards.org/documents/Migrating_from_SSL_Earl
y_TLS_Information%20Supplement_v1.pdf.

•

In the SSL/TLS Minimum Version section, leave the setting at the highest level (TLS 1.2). In accordance
with the warning above, if you have temporary incompatibility issues with your POS/PMS, you may move
the slider to another SSL/TLS minimum version. The level you choose and all levels listed above that
setting will be supported.
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•

3.
4.

Select a Certificate Information option. (See Appendix B – Security Certificates for details.)
(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the BIN
Management tool will automatically determine the card type and process the transaction as debit if the
amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit or
debit if the dollar amount is at or below that Floor Limit.
•

5.
6.

If you select a minimum version that is not secure, the following warning will appear:

The Bin Management Floor Limit specified is the lowest amount for which the Bin Management function
is enabled.

Optional) To print a tip line on the receipt when an authorization is performed, select Print Blank Tip Line on
Authorizations.
(Optional) To print a tip line on the receipt when a sale is performed, select Print Blank Tip Line on Sales.

Note: If either Print Blank Tip Line on Authorizations or Print Blank Tip Line
on Sales is selected, the following should be noted:
•
•
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7.

Click OK.
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Adding an HTTP SSL Interface
The HTTP SSL interface is a web-based interface. This allows web applications to send traffic to Shift4 with much
greater security and reliability than using HTTPS posting directly over the Internet, and it provides an added layer
of security using SSL to secure the local network segment.
To add an HTTP with SSL interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

2.

Under Interface, click Add.
From the Add menu, select HTTP SSL.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 16448 ($4040 hex) is
the default setting.
(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical
Installation Guide for more information.
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Warning! When the term SSL is used throughout this document, it should be
interpreted as the newest version of TLS. In accordance with the PCI Data
Security Standard, all versions of SSL and TLSv1.0 are no longer considered
“strong encryption” and should never be used for non-console access to
card data environments through public networks or to transport card data
over public networks. Shift4 offers the option to use SSL and TLSv1.0 due to
system incompatibility issues with legacy PMS/POS systems, but it should
only be considered a temporary fix. If SSL or TLSv1.0 must be used, it should
only be used inside protected, non-public networks. For more information,
see
https://www.pcisecuritystandards.org/documents/Migrating_from_SSL_Earl
y_TLS_Information%20Supplement_v1.pdf.

•

In the SSL/TLS Minimum Version section, leave the setting at the highest level (TLS 1.2). In accordance
with the warning above, if you have temporary incompatibility issues, you may move the slider to another
SSL/TLS minimum version. The level you choose and all levels listed above that setting will be supported.
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•

3.
4.

Select a Certificate Information option. (See Appendix B – Security Certificates for details.)
(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the BIN
Management tool will automatically determine the card type and process the transaction as debit if the
amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit or
debit if the dollar amount is at or below that Floor Limit.
•

5.
6.

If you select a minimum version that is not secure, the following warning will appear:

The Bin Management Floor Limit specified is the lowest amount for which the Bin Management function
is enabled.

(Optional) To print a tip line on the receipt when an authorization is performed, select Print Blank Tip Line on
Authorizations.
(Optional) To print a tip line on the receipt when a sale is performed, select Print Blank Tip Line on Sales.

Note: If either Print Blank Tip Line on Authorizations or Print Blank Tip Line
on Sales is selected, the following should be noted:
•
•
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7.

Click OK.
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Adding a REST Interface
The REST interface provides a simple integration using standard REST calls. The REST interface currently supports
TLS 1.2 only. The REST API is only available for UTG version 3001 and above.
To add a REST interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

Under Interface, click Add.
From the Add menu, select REST.
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2.

To configure the new interface, complete the following steps:
•
•
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 277 ($0115 hex) is
the default setting.
In the Max Connections field, enter the maximum allowed number of simultaneous connections to the
REST API. The minimum is 1 and the maximum is 999. The default is 6.
(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical
Installation Guide for more information.
In the Certificate Information section, you are provided with two certificate options. You can either use a
valid, signed CA, or you can use the Shift4 Certificate Generator to build a certificate. For more
information, see the Shift4 Certificate Generator document. To use the Shift4 Certificate Generator to
build your own certificate, complete the following steps:
o
o

In the Certificate Information section, click Generate Certificate.
In the Shift4 Certificate Generator window, enter the information for all required fields and any
desired optional fields. The required fields include the following:













o

Set the valid certificate dates in the Dates section. This is the amount of time the certificate can be
used before having to be renewed.



o

Common Name – Enter a name for the certificate.
Organization
Locality – Location city
State/Province – Location state
Country – Location country
The IP address(es) the UTG will listen on for the REST Interface.
Select SelfSigned in the CA Self Signed/Intermediate section.
Select Server Authentication.
Select Client Authentication.
Select CRT – The CRT extension is used for certificates.
Select Embed Key.
Enter a Password for the certificate. You will need this password during the installation.

From – The date the certificate will go into effect.
To – The date the certificate will no longer be accepted and must be renewed.

Select a Key Size:



2048 bit – In general, requests using this certificate will be faster.
4096 bit – In general, requests using this certificate will be more secure but slower.
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•

o

Click Generate.

o
o
o
o
o
o
o

Select a location to store the certificate and click Save.
After you see SUCCESS, close the Shift4 Certificate Generator.
In the REST window, under Certificate File, select Browse.
Select All Files as the file type.
Locate the certificate you just generated.
Click Open.
In the Certificate Password field, enter the certificate password you entered when creating the new
certificate.

(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the
BIN Management tool will automatically determine the card type and process the transaction as debit if
the amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit
or debit if the dollar amount is at or below that Floor Limit.
o

The Bin Management Floor Limit specified is the lowest amount for which the Bin Management
function is enabled.
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•

Click OK.
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Adding a UTG4Cloud Interface
Add a UTG4Cloud® interface to the locally installed UTG of any property that will be using a cloud-based POS/PMS.
The cloud-based POS/PMS will use a standard HTTP or TCP interface based on their communication protocol. The
UTG4Cloud interface is added at the local property’s UTG. For more information, see Appendix A - Using a CloudBased POS/PMS with UTG.

Note: When this interface is in use, the UTG will not utilize its offline
feature (i.e., go offline for at least 30 minutes after receiving one failure
in 30 seconds).

To add a UTG4Cloud interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

2.

Under Interface, click Add.
From the Add menu, select UTG4Cloud.

To configure the new interface, complete the following steps:
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 13107 ($3333 hex) is
the default setting.
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•

From the Transport Format list, select Http. (Tcp is for future use.)

•

(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical
Installation Guide for more information.
Click OK.

•

Note: If you are configuring a UTG4Cloud interface, it is not advisable to
select the Convert Communication Errors to Referrals option when
configuring the Advanced tab. See the Configuring Advanced Parameters
section for more information.
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Adding a UTG4Cloud SSL Interface
Add a UTG4Cloud SSL interface to the locally installed UTG of any property that will be using a cloud-based
POS/PMS. The cloud-based POS/PMS will use a standard HTTP or TCP interface based on their communication
protocol. The UTG4Cloud SSL interface is added at the local property’s UTG. For more information, see Appendix A
- Using a Cloud-Based POS/PMS with UTG.

Note: When this interface is in use, the UTG will not utilize its offline
feature (i.e., go offline for at least 30 minutes after receiving one failure
in 30 seconds).

To add a UTG4Cloud SSL interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

2.

Under Interface, click Add.
From the Add menu, select UTG4Cloud SSL.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 13107 ($3333 hex) is
the default setting.
From the Transport Format list, select Http. (Tcp is for future use.)

© Shift4. All rights reserved.
External Use NDA

Version 5.8
Page 38 of 89

UTG Installation and Configuration Guide

Warning! When the term SSL is used throughout this document, it should be
interpreted as the newest version of TLS. In accordance with the PCI Data
Security Standard, all versions of SSL and TLSv1.0 are no longer considered
“strong encryption” and should never be used for non-console access to
card data environments through public networks or to transport card data
over public networks. Shift4 offers the option to use SSL and TLSv1.0 due to
system incompatibility issues with legacy PMS/POS systems, but it should
only be considered a temporary fix. If SSL or TLSv1.0 must be used, it should
only be used inside protected, non-public networks. For more information,
see
https://www.pcisecuritystandards.org/documents/Migrating_from_SSL_Earl
y_TLS_Information%20Supplement_v1.pdf.

•

In the SSL/TLS Minimum Version section, leave the setting at the highest level (TLS 1.2). In accordance
with the warning above, if you have temporary incompatibility issues, you may move the slider to another
SSL/TLS minimum version. The level you choose and all levels listed above that setting will be supported.
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•

3.
4.

5.

If you select a minimum version that is not secure, the following warning will appear:

(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical Installation
Guide for more information.
Select a Certificate Information option. (See Appendix B – Security Certificates for details.) An example of the
message generated by a user entering incorrect or invalid data is provided below.

Click OK.
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Security Certificate Considerations for UTG4Cloud SSL Interfaces
By default, the UTG generates a self-signed SSL certificate, which can cause an issue for vendors that are
communicating with the UTG4Cloud SLL interface because the browser will be expecting a Certificate Authority
(CA) signed certificate. There are several ways to resolve this issue:
1.

2.
3.

You can act as your own CA by issuing your own root certificate and importing this certificate into the
certificate stores of all of the browsers. This would then allow you to issue individual certificates for each UTG
and sign them yourself, bypassing the cost of getting each one signed by a separate CA. You could also use this
in conjunction with a wildcard certificate, if a subset of your systems is all on the same domain.
Obtain a CA signed wildcard certificate for a fixed domain for all of your locations. This will allow you to use a
single certificate for all of your locations, but will require all of the UTG systems to be on the same domain.
Obtain a separate CA-signed certificate for each UTG instance. This could be a time-consuming and expensive
process, especially if you are implementing a per-terminal UTG setup.

Note: If you are configuring a UTG4Cloud interface, it is not advisable to
select the Convert Communication Errors to Referrals option when
configuring the Advanced tab. See the Configuring Advanced Parameters
for more information.
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Adding an Oracle Payment Interface (OPI)
Requirement: The Oracle Payment Interface (OPI) version must be
6.1.1.14 or higher. If you are not certain what OPI version you are
currently on, consult your OPI installer.

To add an Oracle API interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

Under Interface, click Add.
From the Add menu, select Oracle Payment Interface (OPI).

Note: Only one Oracle Payment Interface (OPI) can be configured per UTG.
If an OPI has already been configured, the OPI option will be gray and
unavailable.
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2.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 8084 (1F94 hex) is
the default setting.
(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the
BIN Management tool will automatically determine the card type and process the transaction as debit if
the amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit
or debit if the dollar amount is at or below that Floor Limit.

Note: When Swipe Ahead is used with BIN Management, the Floor Limit set
in UTG TuneUp is ignored and BIN Management automatically selects debit
if the card is debit capable. If the card is not debit capable, the UTG
prompts the cardholder.

o
3.
4.
5.
6.

The BIN Management Floor Limit specified is the lowest amount for which the Bin Management
function is enabled.

To allow the UTG to generate a certificate at each start up, leave UTG Generated selected. Or, if you want to
provide a certificate for use with the UTG, select Path Provided. Click Select and then follow the prompts to
complete the process. (If needed, see the Shift4 Certificate Generator document.)
Select the desired column width for receipts. The default is 30.
(Optional) To print a tip line on the receipt when an authorization is performed, select Print Blank Tip Line on
Authorizations.
(Optional) To print a tip line on the receipt when a sale is performed, select Print Blank Tip Line on Sales.

Note: If either Print Blank Tip Line on Authorizations or Print Blank Tip Line
on Sales is selected, the following should be noted:
•
•

If the POS sends the tip amount, the tip line will not print on the
receipt.
If the user enters a tip amount on the PIN pad, the tip line will not
print on the receipt.

(Optional) If you don’t want a receipt to be printed when performing a sales completion, select Suppress Sales
Completion Receipts.
8. (Optional) If you don’t want a receipt to be printed when a sale is declined, select Suppress Decline Receipts.
9. (Optional) If you don’t want a signature line to be printed on receipts, select Suppress Signature on Receipts.
10. (Optional) If you don’t want a receipt to print on a user-cancelled transaction, select Suppress Cancelled
Receipts.
7.
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11. (Optional) If you want to omit the void requests due to an issue where erroneous voids are sent while
reopening tickets and return a faux reversal response to the POS, select Return Faux Reversal Response when
Reopening Tickets.
12. (Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical Installation
Guide for more information.
13. Click OK.

© Shift4. All rights reserved.
External Use NDA

Version 5.8
Page 44 of 89

UTG Installation and Configuration Guide

OPI Mapping in the UTG
Once an Oracle interface has been configured and saved in TuneUp, you will need to Map the OPI Site ID to an
Access Token in the UTG Stand Alone. To map the OPI, complete the following steps:
1.
2.
3.

Start the UTG Stand Alone.
From the menu, click OPI Mapping
In the Oracle Payment Interface Site Id Mapping section, click Add.

4.
5.

In the Site Id field, enter the Site ID configured in OPI.
In the Description field, enter a description for the revenue center that will be easy to distinguish if multiple
OPI maps are configured.
In the Auth Token field, enter the auth token generated in LTM.

6.

•

7.

Log in to LTM as the Account Administrator (only the Account Administrator can perform this function)
and generate an auth token for the desired vendor and select Oracle Payment Interface from the
Application list. For more information on generating an auth token, see the Appendix B – API Settings
section of the Account Administrator Guide in Lighthouse Transaction Manager Help.

Click OK.

It is also possible to map multiple site maps at one time by creating a simple text file containing a tab-separated list
of items where each item contains a Site ID, Description, and Auth Token. For example:
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To import a file containing site maps, complete the following steps:
1.
2.
3.
4.

Click Import in the Oracle Payment Interface Site Id Mapping section.
Click Load and locate the text file containing the tab-separated site mapping.
Select the site mapping file and click Open.
Click Process to import the site mapping data.
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Adding an Opera Interface
To add an Opera interface, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the API Interfaces tab and complete the following
steps:
•
•

2.

Under Interface, click Add.
From the Add menu, select Opera.

To configure the new interface, complete the following steps:
•
•
•
•

In the Task Description field, enter a name that identifies this interface.
From the Host Address list, select the IP address the interface will listen to for connections.
In the Port field, enter the port number defined by the Interface Vendor system. Port 8084 ($1F94 hex) is
the default setting.
(Optional) The Clients option is only used with 4Go. If you are using 4Go, see the 4Go Technical
Installation Guide for more information.
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Warning! When the term SSL is used throughout this document, it should be
interpreted as the newest version of TLS. In accordance with the PCI Data
Security Standard, all versions of SSL and TLSv1.0 are no longer considered
“strong encryption” and should never be used for non-console access to
card data environments through public networks or to transport card data
over public networks. Shift4 offers the option to use SSL and TLSv1.0 due to
system incompatibility issues with legacy PMS/POS systems, but it should
only be considered a temporary fix. If SSL or TLSv1.0 must be used, it should
only be used inside protected, non-public networks. For more information
see,
https://www.pcisecuritystandards.org/documents/Migrating_from_SSL_Earl
y_TLS_Information%20Supplement_v1.pdf.

3.

In the SSL/TLS Minimum Version section, use the slider to select the highest level possible for your system. The
level you choose and all levels listed above that setting will be supported.
•
•

For Oracle database 11.2.0.4 or lower, select TLS 1.0.
For Oracle database 11.2.0.4.170531 (OPERA 5.5 or higher), select TLS 1.2.
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4.

(Optional) To enable BIN management, select Bin Management.
In general, merchants prefer to process transactions as debit when the transactions are above a certain
amount and as credit when transactions are below that amount. When BIN Management is selected, the BIN
Management tool will automatically determine the card type and process the transaction as debit if the
amount is above the user defined Floor Limit, or the PIN pad will prompt the consumer to select credit or
debit if the dollar amount is at or below that Floor Limit.
•

5.

The Bin Management Floor Limit specified is the lowest amount for which the Bin Management function
is enabled.

In the Certificate section, complete the following steps:
•

•
•
•

•

(If applicable) To generate a SHA1 certificate, select Use SHA1 Certificate. Older OPERA versions require
the use of SHA1 certificates. This is because the Oracle Database that is used by these systems does not
support SHA2. If you have Oracle Database 11.2.0.4 or higher, you can generate the newer SHA-256
certificate by clearing this field.
Enter the Chain Code (This is found in the OPERA system under Configuration > Property Interfaces >
General Parameters.)
Enter the Property Code (This is found in the OPERA system under Configuration > Property Interfaces >
General Parameters.)
Click Generate Certificate, to generate a persistent certificate.
o
o

Save both the oputg2.pfx and ewallet.p12 file in the UTG folder.
UTG will display the ewallet password. Make a note of the password and provide it to the installer.
The password for the certificate will only appear once. It is the responsibility of the site to record and
manage that password. The installer will need this password for the rest of the installation.

o

Click OK, I Wrote the Password Down.

If you already have a certificate, click Select, locate your certificate, and click Open.
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6.

Click OK.
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Configuring Devices
On the Devices tab, you will notice Limit Simultaneous Downloads. This setting is useful when you are using the
auto form loading feature, as it limits the number of devices that will receive downloads at one time and prevents
overloading. The default is 3. To enter a different number, complete the following steps:
1.
2.

Enter a number between 1 and 10.
Click Save.

It is necessary to configure devices when using a PIN pad. To configure devices, complete the following steps:
1.
2.

In the Universal Transaction Gateway TuneUp window, click the Devices tab.
Under Device, click Add.

v

Note: If you have UTG installed on each terminal, you have to configure
each UTG individually for each device.
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RS-232 Connection Settings
An RS-232 connection is used if the device is directly connected to the UTG machine. To configure the device
information for an RS-232 connection, complete the following steps:
1.

In the Device Name field, enter a unique name that will identify this device. Do not enter a device name that
has already been used. This will result in overwriting the previous device settings and only one device will be
configured.

2.
3.

From the Device Type list, select the payment device. See Appendix C for a list of devices in UTG TuneUp.
In the API Terminal ID field, enter a terminal ID specific to the payment device. See the API Terminal ID note
below for more information.
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Important: The API Terminal ID is a value consisting of 1-32 alphanumeric
characters. It is specific to each PIN pad, and it is specified by the
merchant or POS/PMS provider. Shift4 suggests a naming convention that
keeps the API Terminal ID unique across the merchant’s entire enterprise.
(For example, 70211 where 702 is the store number and 11 is the lane
number where the PIN pad is stationed for use.) The API Terminal ID must
be set in the POS/PMS, UTG, and LTM. The value must match so that
those systems can identify the PIN pad being used during the transaction.

4.
5.
6.

From the Connection field, select RS-232.
In the Timeout field, enter or select a time in seconds. This is the amount of time in seconds (per screen) that
the UTG will wait before returning a No input from customer error. The recommended time for most devices
is 30 seconds. The set time is doubled for swipe/manual entry screens to allow time for manual data entry.
From the Port list, select the port to which the device is connected.
•

If you are only configuring one USB connected device for this UTG, you can select Auto from the Port list.
If Auto is selected, the UTG will automatically search for the COM port assigned to the device. This makes
finding and selecting the Windows assigned COM port unnecessary. The auto setting cannot be used for
multiple devices on the same UTG or for serial connected devices. If you decide later to add more devices
to the UTG, you will need to edit the original device configuration and select the actual COM port to
which it is connected.

Requirement: If you are using Ingenico devices with Windows 7, the
Ingenico device driver must be version 3.14 or later in order to use the
Auto setting.

Note: If your device is shipped with a USB connection, you will need to
virtualize the COM port using the driver supplied by the manufacturer.

7.

From the Baud Rate list, select the connection speed as indicated by the device manufacturer. (See the Using
External Devices guide for more information.)
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8.

If Manual Card Entry is enabled and available for the selected device, choose one of the following:
•
•

If Manual Card Entry is not desired, clear the Enable MCE option.
If Manual Card Entry is desired, to configure the selected device for Manual Card Entry, complete the
following steps:
o
o

Select Enable MCE.
Select the desired setting for Card Security Code (CVV), Street Number, and Zip Code. Required is the
default setting.

Note: For a manually entered transaction when using Ingenico TETRA
devices, the Card Number, Expiration Date, and CVV will be masked when
entered on the device.

•

(If applicable) To configure the Minimum Digits and Maximum Digits that can be entered on a payment
device, complete the following steps:
o
o

In the Minimum Digits field, enter the minimum number of digits that can be entered on the payment
device.
In the Maximum Digits field, enter the maximum number of digits that can be entered on the device.

For example, if you want to restrict the number of digits entered to 20 digits, enter or select 20 in the
Minimum Digits field and then enter or select 20 in the Maximum Digits field.
•

(If applicable) To configure the BIN Range Overrides, complete the following steps:
o
o
o
o
o

Click BIN Range Overrides.
Enter the beginning six-digit BIN in the Starting Range field.
Enter the ending six-digit BIN in the Ending Range field.
Enter the Min PAN length.
Enter the Max PAN Length.

Note: If your card ranges are always 16 digits, enter 16 for the Min PAN
Length and 16 for the Max PAN Length.

o

Select all of the parameters that will be bypassed from the following list:






Bypass CVV (Card security code)
Bypass Exp Date (Card expiration date)
Bypass Luhn (Luhn mod 10 check)
Bypass Street
Bypass Postal Code
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Important: If your card range will not pass the Luhn mod 10 check, be
sure to select Bypass Luhn.

o
o

Click Add.
(If applicable) Add additional ranges. (Up to nine ranges may be configured.)

Note: See the Using External Devices guide for more information and
examples of BIN Range Overrides.

Note: Options displayed on the Add Device screen depend on the device
selected and connection type.

9.

If Additional Options are enabled for your selected device, complete the following steps:
•
•

(If applicable) Enter a Line Length. This is the length of the text line on the device before wrapping the
text.
(If applicable) Enter a Beep Volume. This is the volume level the device will beep for actions, such as
pressing a button or EMV card removal prompt. Enter any number between 0 and 100 considering the
following:
o
o

•

•
•
•

(If applicable) Enter a Debit Key Index number. Ingenico Telium RBA devices have the ability to be injected
with up to five keys. This allows the same device to be used for multiple processors. Debit Key Index 0, 1,
2, 3, and 5 are available. Debit Key Index 4 is reserved for P2PE keys. If you are using an Ingenico Telium
RBA device and know the desired Debit Key Index, enter the number. The default is 0.
(If applicable) Enter an Amex Key Index number to support using a different key slot for the Online PIN key
when processing an Amex EMV card.
(If applicable) If you are using Dynamic Currency Conversion (DCC), in the DCC Timeout field, enter the
amount of time in seconds before a request for a currency conversion rate times out. The default is 3
seconds.
(If applicable) Enter the Source Serial Number. This option is used if the device is going to be processing
transactions under a different serial number than the one configured for the UTG on the Express tab.
o

•

Entering 0 = volume off
Entering 100 = full volume

For example, if a merchant has a single UTG configured under SN 1, a device configured under SN 2
and another device configured under SN 3, the terminal download process would work for both of
the devices even though they are under different serial numbers from the UTG.

(If applicable) Select the default language to be displayed on the device. The current options include:
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o
o
o
•

•

•

(If applicable) Select the Default Receipt language. Currently, this is only for configuring an Ingenico
IPP320 CAN. The option sets the receipt language for the merchant copy when using enhanced receipts
and both the merchant and customer copy when using non-enhanced receipts. It allows you to set the
receipt language to either English or French.
(If applicable) Enter the desired Post-Connect Delay time. The Post-Connect Delay feature provides a
configurable timer to set the number of seconds to wait after connecting to the device before sending it
any commands (for example, when a device reboots). If a command is sent too quickly after connection,
the device may get stuck on a gray screen. The default setting is 90 seconds for all Tetra devices, while the
setting range is from 0 – 99 seconds. Adjust this setting to the fastest time that does not cause a problem
after the device connects. If you are using UPP version 6.80.05 or higher, the gray screen issue is resolved
and the value should be set to zero (0).
(If applicable) Enter the desired reboot time. The Reboot Time option is provided to satisfy a PCI
requirement for devices that are PCI version 4 and above. To satisfy the PCI requirement, the devices
must be rebooted every 24 hours. The Reboot Time option allows you to set a convenient time when the
device will automatically be rebooted.
o

o

•
•
•
•

English
Spanish
French

The Reboot Time setting will be read and set in the device and take effect ONLY after the device has
rebooted once after it starts up. The device may or may not automatically reboot after it starts up.
For example, if the reboot time currently set in the device is different than the setting in UTG Tune-up
and UTG restarts, the UTG will force the device to reboot once after it starts up. If the device does
not reboot after it starts up, you can choose to manually reboot the device or it will reboot
automatically based on the reboot time currently set in the device if the reboot flag is enabled in the
device.
The Reboot Time settings will be ignored for RBA PCI version 4 devices with application version below
v21.5.6. The full model name for these devices cannot be read by the UTG. Without the full model
name, the UTG cannot determine whether the device is PCI version 4 or above. Therefore, the device
will automatically reboot every 24 hours based on the reboot time currently set in the device if the
reboot flag is enabled in the device.

(If applicable) Contactless Enabled is selected by default for all RBA devices. To disable Contactless, clear
the option. (Contactless payment systems use radio-frequency identification [RFID] or near field
communication [NFC] for making secure payments.)
(If applicable) Select EBT Cash Enabled to enable the device to be prompted for EBT Cash in an EBT
transaction.
(If applicable) Select EBT Food Enabled to enable the device to be prompted for EBT Food in an EBT
transaction.
(If applicable) Select Bypass Amount OK to bypass the amount confirmation screen on the device.

10. (If applicable) Private Label cards is discussed in detail in the Device Options for Private Label Cards section.
11. (If applicable) To enable cashback to be prompted on the device, click Cashback and then select Enable.

Requirement: Cashback must be supported on your POS/PMS for the
UTG TuneUp settings to work.
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•

(Optional) Edit the amounts that will be displayed on the device as cashback options:
o
o
o
o
o

(Optional) Edit the First Amount. The default is 20.00.
(Optional) Edit the Second Amount. The default is 40.00.
(Optional) Edit the Third Amount. The default is 60.00.
(Optional) Edit the Fourth Amount. The default is 80.00.
(Optional) Edit the Maximum Amount. The default is 200.00.

Note: If Cashback is enabled, the five amounts configured above will be
displayed. If you don’t want to display all of the buttons, refer to the Using
External Device guide for help.

•

Click OK.

12. (If applicable) To enable tip to be prompted on the device, click Tip and then complete the following steps.
•

Select Enable Tip and then choose one of the following:
o
o

(Optional) Select No Presets to disable the preset percentages or amounts and prompt the consumer
to enter a tip amount.
(Optional) Select Percent and enter up to 4 tip percentages that will be displayed on the PIN pad
when prompting for tip.





In the First Percent field, enter a percent tip option.
In the Second Percent field, enter a percent tip option.
In the Third Percent field, enter a percent tip option.
In the Fourth Percent field, enter a percent tip option.
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Note: Percent fields are displayed on the device from left to right. Entering
a zero in any of the fields will cause that field to not be displayed on the PIN
pad. For example, if you only want to display three tip options (10%, 15%,
and 20%), you could enter zero in the First Percent field, 10 in the Second
Percent field, 15 in the Third Percent field, and 20 in the Fourth Percent
field. Only the first three fields would be displayed on the PIN pad.

o

(Optional) Select Amount to enter up to 4 set amounts that will be displayed when prompting for tip.





In the First Amount field, enter the desired set amount.
In the Second Amount field, enter the desired set amount.
In the Third Amount field, enter the desired set amount.
In the Fourth Amount field, enter the desired set amount.

Note: Amount fields are displayed on the device from left to right. Entering
a zero in any of the fields will cause that field to not be displayed on the PIN
pad. For example, if you only want to display three tip amount options (1,
5, and 10), you could enter zero in the First Amount field, 1 in the Second
Amount field, 5 in the Third Amount field, and 10 in the Fourth Amount
field. Only the last three fields would be displayed on the PIN pad.

o

Click OK.

13. Click OK.
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Device Options for Private Label Cards
If you select any of the device types listed below from the Device Type list, the private label option is enabled:
•
•
•

All Ingenico RBA devices
Verifone MX915 P2PE
Verifone MX925 P2PE

Once you have selected one of the listed device types, clicking Private Label brings up the Private Label Prompt
window allowing you to customize what will be displayed on the PIN pad device when a customer applies for a
private label card. The Private Label Prompt window provides options under the three headings listed below.

Prescreen Application
The Prescreen Application uses the applicant’s postal code to determine the likelihood of the applicant
being approved for a private label card based on the average credit rating in postal code entered.

Prescreen Acceptance Application
The Prescreen Acceptance Application indicates a Prescreen Application approval and requests additional
information from the applicant to complete a private label application approval.

QuickCredit Application
The QuickCredit Application is an abbreviated individual credit application requiring less applicant
information than the full credit application. To be eligible to apply using the Quick Credit process, the
applicant must have a major bank card (Visa, MasterCard, American Express, or Discover).

InstantCredit Application
The InstantCredit Application is a private label card application based solely on the supplied information,
and forgoes any Prescreen Application.

Pre-approved Application
The Pre-Approved Application process starts with an applicant receiving a pre-approved offer in the mail.
This offer contains a twelve-digit certificate number which associates the applicant with a pre-approved
offer of credit. The Pre-Approved Application requires fewer input data items than the full application.

Account Lookup
Account Lookup allows the merchant to obtain cardholder account information from the cardholder’s
Social Security Number (SSN) or SSN and Zip code or SSN and Date of Birth. Inquiries are used when the
cardholder does not have their card available at the time of purchase.
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Configuring Private Label Prompts
To configure the options for Private Label Cards, complete the following steps:
1.
2.
3.

From the Universal Transaction Gateway TuneUp window, click the Devices tab.
In the Add Devices window, from the Device Type list, select one of the devices listed at the beginning of this
section. If you select a device type that is not listed, the Private Label option will not be available.
Click Private Label.
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4.

On the Private Label Prompt screen, select your desired options and click OK.

Note: Contact your private label card processor to determine all required
fields.
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Option Definition Table
Private Label Prompt Options

Definition

SSN (Social Security Number)

If selected, the applicant will be prompted to enter their social
security number.

SSN Last 4

If selected, the applicant will be prompted to enter the last four
digits of their social security number.

Zip Code

If selected, the applicant will be prompted to enter their ZIP/postal
code.

Date of Birth

If selected, the applicant will be prompted to enter their date of
birth.

Income

If selected, the applicant will be prompted to enter their annual
income.

Signature

If selected, the applicant will be prompted to sign the PIN pad
device.

Promo Text

If selected, the % of Amount entered for each Period selected will be
displayed to the applicant on the device and printed on the receipt.
Note: The % of Amount is used to calculate the required fixed
monthly payment for the corresponding promotional time Period
during a private label card promotion.
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TCP/IP Connection Settings
When a Point-to-Point Encryption (P2PE) PIN Pad device is selected, a third connection option is available.
A TCP/IP connection is used if the device is connected directly to the network via an Ethernet cable rather than
directly connected to a PC. Only P2PE devices can use this connection.
To configure the device information for a TCP/IP connection, complete the following steps:
1.
2.

From the Device Type list, select the payment device. See Appendix C for a list of devices in UTG TuneUp.
In the API Terminal ID field, enter a terminal ID specific to the payment device. See the API Terminal ID note
below for more information.

Important: The API Terminal ID is a value consisting of 1-32 alphanumeric
characters. It is specific to each PIN pad, and it is specified by the
merchant or POS/PMS provider. Shift4 suggests a naming convention that
keeps the API Terminal ID unique across the merchant’s entire enterprise.
(For example, 70211 where 702 is the store number and 11 is the lane
number where the PIN pad is stationed for use.) The API Terminal ID must
be set in the POS/PMS, UTG, and LTM. The value must match so that
those systems can identify the PIN pad being used during the transaction.

3.
4.
5.
6.
7.

Under Connection, select Direct TCP/IP.
In the Timeout field, enter or select a time in seconds. This is the amount of time in seconds (per screen) that
the UTG will wait before returning a No input from customer error. The recommended time for most devices
is 30 seconds. The set time is doubled for swipe/manual entry screens to allow time for manual data entry.
In the Address field, enter the static IP address of the P2PE device.
In the Port field, enter the port to which the P2PE device is listening. (The default port is 12000.)
See steps 8 through 12 under the RS-232 Connection Settings section for help with Manual Card Entry,
Additional Options, Cashback, and Tip settings.
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8.

Click OK.

Requirement: For EMV devices, the UTG TuneUp API Terminal ID must
match what is in the API Terminal field on the EMV Device Settings page in
LTM.
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Configuring 4Go
4Go® is a persistent application that intercepts cardholder data. It secures both swiped and manually entered
cardholder data by replacing it with either a temporary false card number or a TrueToken®. The actual cardholder
data is only stored by Shift4. No actual cardholder data ever exists in the POS/PMS application’s logs, database, or
transport mechanisms.
While monitoring the swipe data, 4Go also helps prevent tampering of the keyboard or swipe device by ensuring
that no other application is able to intercept the swipe device’s data stream. 4Go can be used with most standard
swipe devices.
For complete instructions on installing and configuring 4Go, see the 4Go Technical Installation Guide.
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Configuring Express Parameters
The Express parameters control and define the connections used to communicate with the Shift4 data centers. To
configure UTG Express parameters, in the UTG TuneUp window, click the Express tab.

Identity Parameters
The Identity parameters must be set in order to identify the computer running the UTG and define the connection
used to communicate with Shift4. To configure the Identity parameters, complete the following steps:
1.

To configure each option in the Identity section, complete the following steps:
•
•
•

In the Serial field, enter the serial number provided by the Shift4 Installations team.
In the Slot field, enter the slot number provided by the Shift4 Installations team.
The unique slot number is used to verify the current connection to Shift4 as it applies to the UTG. Contact
the Shift4 Installations team at 888-276-2108 for additional slots if multiple UTGs will be installed.
In the Host Address list, select the local IP address of the computer running the UTG.
If the computer running the UTG has more than one IP address, use a static address (not DHCP) on the
subnet that will route traffic to Shift4's data centers using the Internet or a private TCP/IP connection.

WARNING! Because of the extensive security requirements of Shift4, any
change to the IP address will affect the UTG and prevent successful
operation. Contact the Shift4 Support team to allow activation if the IP
address needs to be changed after any transactions have been processed.

•

In the Location field, enter the ZIP/postal code where the UTG is installed.

Note: If all of your interfaces are using Access Tokens, you can leave the API
Serial Number, API Password, and Verify API Password fields blank.

•

•

•

In the Api Serial Number field, enter the Shift4 API serial number.
The API serial number, provided on the Customer Configuration Report, is used to route transactions to
the appropriate merchant at Shift4's data centers. The API serial number is used only if the data is not
included in each API request of the interface vendor system.
In the Api Password field, enter the Shift4 API password.
The API password, along with the API Serial Number, is used to authenticate transactions to ensure they
are routed to the appropriate merchant at Shift4's data centers. The password is case-sensitive and must
always match the password given on the Customer Configuration Report.
In the Verify Api Password field, reenter the Shift4 API password.
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2.

The Gateway section contains necessary settings to connect to the Shift4 data center. In the Gateway section,
review the Address, Port, Route Code, Max Score, and Environment.
•

The Address will be automatically populated when you select Test or Production in the Environment
section.
o
o

•

Production - Always use this option with actual card numbers. (Production is the default setting.)
Test - Use Test only during development and testing in a lab with test card numbers.

If you are using Commerce Engine to Store and Forward (SAF) with this UTG, select Use Commerce Engine
and complete the following steps:
o
o

Enter the IP address of the Commerce Engine SAF configuration.
Enter the port number that will be communicating with Commerce Engine SAF configuration. The
default is 9366.

WARNING! Do not change the Gateway Address and Port Settings unless
instructed to do so by your IT department or the Shift4 Support team.
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Configuring Options
The UTG TuneUp Options tab provides options to configure the UTG’s internal web server, notifications, and the
UTG FTP server.
•

In the UTG TuneUp window, click the Options tab.
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Configuring Notifications
The UTG will send alert and status emails to specified users through the Mail Notification window. If messages of
either type are received, contact the Shift4 Support team at 888-276-2108.

Alerts
Alert emails notify users of abnormal conditions that require action. Conditions that generate alert emails include
but are not limited to the following:
•
•
•
•
•
•
•

Low disk space warnings, if configured
Thread fails (Task fails to complete)
Unmanaged restarts
Failed connections
Trace archive failed
I/O errors
PIN pad errors

Below are examples of Alerts:
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Status
Status emails notify users of conditions that may require action.
Below is an example of a Status:

To add mail notifications, complete the following steps:
1.
2.
3.
4.
5.
6.
7.
8.
9.

In the Universal Transaction Gateway TuneUp window, click the Options tab.
Under Option, click Add.
From the Add menu, select Notification.
In the Mail Server Name field, enter the SMTP server name where the UTG will send emails.
In the Port field, enter the port (usually 25) the UTG will use to send the notifications.
In the Source Domain field, enter the message's origination domain address.
(Optional) In the Alert Recipients field, enter the email addresses of alert message recipients. Use semicolons
or commas to separate email addresses.
(Optional) In the Status Recipients field, enter the email addresses of status message recipients. Use
semicolons or commas to separate email addresses.
Click OK.
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Configuring Advanced Parameters
Advanced parameters contain a number of important settings, including Trace configuration. Many of the options
are set by default and should not be changed unless instructed by Shift4.
To configure UTG Advanced parameters, complete the following steps:
1.

In the Universal Transaction Gateway TuneUp window, click the Advanced tab. Most of the visible options on
the Advanced tab must be enabled or defined.

WARNING! The options listed in this section can be configured as directed.
Do not change default settings that are not listed in this document without
contacting Shift4.

2.

Do not change any of the default settings under System with the following exception:
•

3.
4.

Cloud Timeout Override – If you are using a UTG4Cloud or UTG4CloudSSL interface, Shift4 suggests that
you set the Cloud Timeout Override at 120 seconds. Since the override setting is for the UTG in the cloud,
this will allow time for the local UTG to complete transactions. If you experience data center timeouts
happening before the local UTG can finish processing transactions, increase the Cloud Timeout Override
setting accordingly. (When this setting is greater than 0, the UTG will not utilize its offline feature [i.e., go
offline for at least 30 minutes after receiving one failure in 30 seconds]).

Under Signature Compression, the default is set to Enabled and Maximum Bytes is at 4096 (in KB).
Under Memory Monitor, complete the following steps:
•
•
•

To send an email snapshot of memory usage, current status, and current configuration to the destination
email address listed, select Enabled.
From the Frequency list, select a predefined interval.
In the Destination field, enter the recipient's email address. Separate multiple addresses with semicolons
or commas.
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5.

Under Options complete the following steps:
•
•
•

Max Threads – To change the maximum number of allowed threads in the UTG, you must obtain a unique
code from the Shift4 Customer Support team. Click the Max Threads button for further instructions.
The API Overrides option is customer specific; do not select this option unless instructed to do so by a
Shift4 Support Representative. See the UTG Reference Guide for further instructions.
Click Trace Configuration to configure the parameters for your trace files.

o
o
o
o
o
o
o
o

o

In the Directory field, the default path is C:\Shift4\UTG2\UTG Trace.
In the Max Files field, enter or select the maximum number of trace files. (This is the maximum
number of files retained without enabling High Capacity.)
In the Blocks field, enter or select the number of lines of trace to be displayed in the Filter form.
Above this number, the oldest blocks will be discarded from memory.
In the Bytes Each field, enter the amount of trace to save in each file.
(Optional) In the Suffix field, enter any two-digit character combination. Suffix characters are used to
distinguish these trace files from other trace files. If unused, leave this field blank.
(Optional) Select High Capacity. With High Capacity selected, the trace files will be zipped rather than
overwritten when capacity is reached.
(Optional) If High Capacity is selected, select the files per zip (between 8 and 64). This is the number
of trace files generated before being zipped.
(Optional) Select the Days Cutoff (between 5 and 120). This is the number of days zipped trace files
will be kept before they begin to be overwritten.
Example: If 5 is selected, zipped trace files will be stored for 5 days. On the sixth day, the first day’s
trace files will be overwritten and the trace subsequently lost.
Select Verbose. Selecting Verbose provides complete transaction data in the trace files and is
necessary for any trouble shooting.
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o

•

Click OK.

Click Splunk Configuration to configure the parameters for UTG to write out log files that are in a Splunk
friendly format.

o

(Optional) To enable Splunk logging, select Enable.

Important: Shift4 highly recommends that you enable Splunk logging if
you are using a REST interface.

o In the Directory field, enter the desired directory where the files will be stored.
o In the Max Files field, enter or select the maximum number of Splunk files.
o In the Bytes Each field, enter the amount of Splunk files to save in each file.
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o
o
o

6.

(Optional) Click Adv Device Configuration to set some advanced configuration settings for your devices.
•
•

7.

(Optional) Select Mask AccessToken to mask the access token.
(Optional) Select Mem Tracking Enabled, to track memory usage.
Click OK.

In the Device Startup Limit field, you can set a limit for how many devices will start up at one time.
In the Device Form Update Limit field, you can set a limit for how many devices will receive form updates
at one time.

Under Preferences:
•

Select Convert Communication Errors to Referrals if your Interface Vendor System allows handling
communication error responses as referrals.

Note: If you are configuring a UTG4Cloud interface, it is not advisable to
select the Convert Communication Errors to Referrals option.

•

•

The Send Alert Messages to Shift4 option allows you to send alert messages to Shift4 in addition to
recipients listed in the Mail Notification window. If this option is not selected, alert messages will only be
sent to recipients listed in the Mail Notification window. Select Send Alert Messages to Shift4 to send
alert messages to Shift4, regardless of Mail Notification window settings.
The Transaction Cache Enabled is selected by default. This enables the transaction cache to hold the last
hours’ worth of debit transactions and reply with the same response to a duplicate debit request received
from an interface.
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•

In the Low Disk Space Warning Threshold field, enter the minimum amount of disk space to use for trace
before sending an alert email to the addresses specified in the Mail Notification window.
In the QR Payment section, set the amount of time before a QR payment will time out.

•

Do not modify UTG or in4m settings unless instructed to do so by Shift4’s Customer Support team.

•
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Configuring Offline Mode
Each UTG should utilize its offline feature (i.e., go offline for at least 30 minutes after receiving one failure in 30
seconds). By default, the UTG will also be enabled to stand in and provide offline approvals so you can continue
processing transactions. The UTG will store the transaction requests below the set Stand-In Limit Amount in an
encrypted file. Once back online, the UTG will attempt to authorize those transactions. Any transaction that is
unable to be authorized will have to be resolved by the auditor.

Note: The authorization code received when offline is temporary and will
be replaced with a permanent authorization code when the UTG is able to
connect to the Shift4 data center and if the transaction is approved by the
processor.

Important: When updating to UTG version 3133 or later, the behavior is as
follows:
If Enable Stand-in* is disabled on all interfaces, it will be enabled
and the Stand-In Limit Amount will use the default of $250.
• If Enable Stand-in* is enabled on all interfaces and the Stand-In
Limit Amount is set to $0, it will be updated to the default of $250.
• If Enable Stand-in* is enabled on any interface and the Stand-In
Limit Amount is set to a value greater than $0, it will be updated to
that value.
*If you are using UTG version 3140 or later, then the Enable Stand-in field is
no longer displayed on the Offline Mode tab in UTG TuneUp because it is
now always enabled by default.
•

There are additional offline options you can configure if needed. To configure the other offline options available,
complete the following steps:
1.
2.

In the Universal Transaction Gateway TuneUp window, click the Offline Mode tab.
(If applicable) To configure Stand-in Options, complete the following steps:
•

•

Maximum Hours – Enter the maximum number of hours the UTG will stay offline. (This is a fail-safe in
case the POS/PMS never sends the request to go back online. This way the UTG will automatically come
back online after the set number of hours, preventing a POS/PMS from putting the UTG offline for days or
weeks.)
Stand-In Limit Amount – Enter the desired amount. The default is 250. (When the UTG is offline, it
returns an approval and a token on all authorization and sale requests that are below the amount and a
referral and a token on all non-EMV authorization and sale requests that are above the amount. For EMV
transactions that are above the amount, a decline is returned.)
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Note: PIN debit is not available when offline since it is not possible to
validate the PIN number unless the system is online.

3.

(If applicable) To configure Advanced Offline Options, complete the following steps:
•

•

Return Error on Void if Offline – If selected, this option allows an error message (function not supported
when offline) to be sent when the POS/PMS is attempting to send a void (08) and the UTG is unable to
connect to the data center. (By default, this option is disabled. However, it is recommended that it be
selected to enable the feature.)
Decline All Non-Bank Cards – If selected, the UTG will return a declined response on all non-bank cards
when offline. (This option is disabled by default.)

Note: When the UTG is offline, if a gift card transaction is sent with a token
rather than card information, the UTG cannot determine if the card is a gift
card. The transaction will be treated as a credit card transaction even if the
Decline All Non-Bank Cards option is selected. The transaction will follow
the other Offline Mode settings as a credit card.

•
•

Transaction Storage Period – Enter the maximum number of days the UTG will retain offline records. (The
default is 60.)
Max Upload Attempts – Enter the maximum number of times the UTG should attempt to upload each
record in the encrypted file when transitioning back to online.
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Data Center
The Data Center tab is not currently used.
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Finalizing your UTG Configuration
When you have finished configuring the UTG to your desired settings, click Save in the Universal Transaction
Gateway TuneUp window to save all your settings.

Testing the UTG Configuration
To verify the UTG configuration, complete the following steps:
1.
2.
3.

From the Start menu, select Programs > Shift4 > Universal Transaction Gateway > UTG (v2) Stand Alone. The
default UTG functions start automatically and are marked by checked boxes.
Verify the text NO ROUTES is not displayed in the Routes section of the screen. The text NO ROUTES in the
Routes setting is significant; it indicates that there is either no connection to the Internet or the necessary
ports are not open. If the words NO ROUTES appear, contact your IT department to correct the problem.
Verify that KeyPage SUCCESS is displayed next to TCPClient in the top section of the screen. If these words do
not appear within 20 seconds and there is not a problem with your Internet connection, contact the Shift4
Support team at 888-276-2108.
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Running UTG as a Service
The UTG can also be configured to run as a service. The UTG service runs continuously in the background of its
respective machines. By default, it starts automatically when the machine boots up.

Requirement: If the UTG Stand Alone is running, you must stop it before
running the UTG service. The UTG Stand Alone and the UTG service
cannot run concurrently.

To start UTG as a service, start Shift4 UTG2 from Windows Services.
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Appendix A – Using a Cloud-Based POS/PMS with UTG
A UTG4Cloud interface option for Shift4’s UTG provides security for local properties using cloud-based point-ofsale (POS) and property management systems (PMS). Using Shift4’s UTG4Cloud API with a cloud-based POS/PMS
only requires a few additional device registration steps to process a request through a UTG-controlled PIN pad at
the local property. The Processing an Authorization Request Using a Cloud-Based POS/PMS section describes the
transaction flow and includes the use of a UTG-controlled device (for example, an EMV device).
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Processing an Authorization Request Using a Cloud-Based POS/PMS

11.

3.

6.

Shift4 Data Center

12.

9.

13.

8.

UTG®
in the Cloud

4.

7.

14.

Cloud-Based
POS/PMS

Local Property
1.

2.

UTG4Cloud® API Interface
5.

10.

Internet Browser

UTG Controlled Device

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

A transaction is initiated at a local property that is using an Internet browser to access a cloud-based
POS/PMS.
The browser at the local property sends a request to connect their UTG to the Shift4 data center. Note: It is
the local property’s UTG that uses the UTG4Cloud API Interface.
The local property’s UTG4Cloud establishes a connection to the Shift4 data center.
The Shift4 data center generates and returns DeviceService, DeviceGuid, and DeviceExtensions to the local
property’s UTG4Cloud.
The local property’s UTG4Cloud sends the DeviceService, DeviceGuid, and DeviceExtensions to the local
property’s browser.
The local property’s browser sends the DeviceService, DeviceGuid, DeviceExtensions, and TERMINALID to the
cloud-based POS/PMS.
The cloud-based POS/PMS sends the authorization request, including the DeviceService, DeviceGuid,
DeviceExtensions, and TERMINALID to the UTG in the cloud.
The UTG in the cloud sends the authorization request, including the DeviceService, DeviceGuid,
DeviceExtensions and TERMINALID to the Shift4 data center.
The Shift4 data center sends the authorization request to the local property’s UTG4Cloud.
The local property’s UTG4Cloud processes the authorization request with a UTG-controlled device.
The local property’s UTG4Cloud returns the response to the Shift4 data center.
The Shift4 data center forwards the response to the UTG in the cloud.
The UTG in the cloud forwards the response to the cloud-based POS/PMS.
The cloud-based POS/PMS forwards the response to the local property’s browser.
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Appendix B – Security Certificates
The UTG provides three options for certificate generation when configuring a TCP/IP SSL, HTTP/SSL, or
UTG4CloudSSL interface:
1.
2.
3.

The UTG can generate a certificate at each start up.
The UTG can generate a persistent certificate during configuration.
The user may provide a certificate.

UTG Generated Certificate
If your POS/PMS application is not browser-based, this might be a good option. If you choose to generate a
certificate using this feature, the default certificate duration is two years.
To allow the UTG to generate a certificate at each start up, complete the following steps:
1.
2.

Under Certificate Information, leave the default Use UTG Generated Certificate selected.
Click OK.
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If you select Use UTG Generated Certificate, you may also select the Use SHA1 Certificate option. However, the use
of SHA1 SSL Certificates is being deprecated due to security issues and is not recommended. You should only utilize
this option if your POS/PMS vendor has issues with the SHA2 certificate. If you choose this option, the following
warning will be displayed.

Generating a Persistent Certificate
If your POS/PMS needs a consistent certificate each time it connects to the UTG, even after a UTG reboot, you can
use this option to generate a persistent certificate. This might be a good option for browser-based POS/PMS
systems.
When generating a persistent file, the UTG will output two separate files:
•
•

One file will contain both the public certificate and the private key.
The other file will contain just the public certificate.

To generate a persistent certificate during configuration, complete the following steps:
1.
2.

In the Certificate Information section, click Generate Certificate.
In the Certificate Format list, select the certificate type you want to generate.
•
•

3.
4.

Typically, PFX is used in Windows environments.
Typically, PEM is used in Linux environments.

In the Valid from and to section, select the date the certificate will begin being valid and the date it will end
being valid.
In the Common Name field, enter the fully qualified domain name or IP address that clients will use to reach
your server. This is typically the Host Address setting for the interface that you are generating the certificate
for. (See the example below.)

© Shift4. All rights reserved.
External Use NDA

Version 5.8
Page 84 of 89

UTG Installation and Configuration Guide

5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

In the Organization field, enter the exact legal name of your organization.
(Optional) In the Organizational Unit field, enter the department within your organization that you want to
appear in the certificate.
(Optional) In the Email Address field, enter the email address that you want to appear in the certificate.
In the City field, enter the city where your organization is located.
In the State/Province field, enter the state or province where your organization is located.
In the Country field, enter the country where your organization is located. This is the 2-character ISO country
code value. For example, the United States ISO code is US.
In the Key Size list, select the size of the RSA key to use for certificate generation. RSA 2048 is the standard key
size. Selecting RSA 4096 will utilize a larger key for better security, but will require higher CPU utilization.
In the Private Key Password field, enter a password for your private key. This password will be used to encrypt
the private key.
In the Verify Private Key Password field, reenter the password.
Click Generate.

© Shift4. All rights reserved.
External Use NDA

Version 5.8
Page 85 of 89

UTG Installation and Configuration Guide

User Provided Certificate
To provide a certificate for use with the UTG, complete the following steps:
1.

Clear Use UTG Generated Certificate if selected.

2.
3.
4.

In the Certificate File field, enter the certificate path or click Browse and select the desired certificate file.
Enter the Certificate Password.
If a Private Key File is required, enter the path in the Private Key File field or click Browse and select the
Private Key File.
Enter the Private Key Password in the Private Key Password field.
Click OK.

5.
6.

The UTG will attempt to load and validate the certificate from the file. If there are any issues uploading or
validating the provided file, the UTG will display a message describing the problem. The user will then be returned
to the API screen with blank Certificate and Private Key fields. Some examples would be:
•
•
•

Choosing a certificate file that requires a separate private key file, but not providing the key file.
Choosing a certificate file that already incorporates the private key, yet providing a private key file
anyway.
Providing no password or the wrong password for a password protected certification/key file.

The UTG cannot be used to specify the password. You must enter the password already associated with the file.
An example of the message generated by a user entering incorrect or invalid data is provided below.
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Appendix C – Table of Listed Devices in UTG TuneUp
Note: The old Form Designer utility for the Ingenico 3070, 6550, and 6780
loads forms on those devices in uppercase and lowercase, whereas the new
Form Designer loads the forms in lowercase only.
Refer to your Ingenico documentation if you do not know which form
designer is in use.

For this device...

Select this setting...

Ingenico iPP320 CAN

Ingenico iPP320 CAN

Ingenico iPP320 P2PE

Ingenico iPP320 RBA

Ingenico iPP350 P2PE

Ingenico iPP350 RBA

Ingenico iSC250 P2PE

Ingenico iSC250 RBA

Ingenico iSC350 P2PE

Ingenico iSC350 RBA

Ingenico iSC480 P2PE

Ingenico iSC480 RBA

Ingenico iUC285

Ingenico iUC285 RBA

Ingenico iUP 250

Ingenico iUP250 RBA

Ingenico iWL 252

Ingenico iWL252 RBA

Ingenico iWL 258

Ingenico iWL258 RBA

Ingenico iCMP

Ingenico iCM122 RBA

Ingenico iSMP Companion

Ingenico iMP352 RBA

Ingenico iSMPv4 without bar code scanner

Ingenico iMP627 RBA

Ingenico iSMPv4 with bar code scanner

Ingenico iMP657 RBA

Ingenico Lane/3000

Ingenico Lane 3000

Ingenico Lane/5000

Ingenico Lane 5000

Ingenico Lane/7000

Ingenico Lane 7000

Ingenico Lane/8000

Ingenico Lane 8000

Ingenico Move/5000

Ingenico Move 5000

Ingenico Link/2500

Ingenico Link 2500

PAX BroadPOS

PAX BroadPOS
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For this device...

Select this setting...

Verifone® MX915 P2PE

Verifone MX915 P2PE

Verifone® MX925 P2PE

Verifone MX925 P2PE
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Appendix D – POS/PMS Timeout Settings
Most POS/PMS interfaces have a configurable timeout setting that is in their application. This setting is
independent of UTG Offline Mode settings. You should never make this setting lower that 65 seconds. If you are
using UTG-controlled devices, we recommend a minimum of 120 seconds.
For information on UTG Offline Mode settings, see the Configuring Offline Mode section of this document.
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